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1. Lwu y quan trong

S tay str dung dién ttr nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trudc khi st dung man hinh. Sé tay
bao gdm nhirng théng tin va cac luu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cta Philips ap dung v&i
didu kién la san phdm phéi dwoc st dung
ding cach theo muc dich st dung, theo
cac hudng dan hoat déng cung vai viéc
xuét trinh hoa don gbc hodc bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mau ma va ma s6 san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

) Canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay cé thé
khién nguwoi dung dé bj dién giat, gap cac
rai ro vé dién va/hodc co hoc.

Hay doc va thwe hién theo cac hwéng dan
sau khi két ndi va str dung man hinh may
tinh.

Hoat dong

« Hay dat man hinh & khu vyc khéng cé
anh sang truwe tiép ctia mét, anh sang
ric c6 cwong dd manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh 1au ngay trong mai trvdng nay co
thé khién cho man hinh bi bac mau va
héng.

« Di chuyén moi db vat c6 thé roi vao
céac 16 théng gié ctia man hinh hoac
ngan can qua trinh lam mat thich hop
cla céc thiét bj dién t&r bén trong man
hinh.

+ Khoéng bit kin cac 16 théng gi6 trén voé
man hinh.

Dam bao d&t man hinh & gan noi cé
phich cdm va & c&m dién.

Néu tat man hinh béng cach rat cap
ngudn hodc day dién DC, hay doi 6
giay trwde khi cdm cap ngudn hodc
day dién DC dé man hinh hoat dong
binh thuwong.

Hay luén dung cap ngudn chuan dugc
cAp bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tdm thong tin tiéu dung
cham séc khach hang)

Khong dat man hinh & noi bj chan
dong hay va cham manh khi dang
hoat dong.

Khéng dap hodc lam roi man hinh khi
dang hoat dong hoac khi di chuyén.

Bao dwdng

D& man hinh khéng bi hdng, khéng dé
nén qua manh lén mat man hinh LCD.
Khi di chuy&n man hinh, hay ndm chat
khung man hinh d& nhéc I&n; khong
nhéc man hinh béng cach dat ban tay
hoac ngon tay 1én mat man hinh LCD.
Rt phich cdm man hinh néu ban
khéng dinh st dung no trong th&i gian
dai.

Rut phich cdm man hinh néu ban can
lau chuii man hinh bng mét miéng

vai hoi wét. Ban co thé lau man hinh
b&ng vai kho khi da ngat dién. Tuy
nhién, dirng bao gio dung dung moi
hiru co, chdng han nhw cdn hodc cac
chét 16ng c6 ngudn gbc tir amoniac dé
lau man hinh.

Dé tranh nguy co bj dién giat hodc
hdéng vinh vién bd man hinh, khéng
dat man hinh & noi ¢é bui, mwa, nwéc
ho&c & noi qua am wot.

Néu man hinh bj wét, hay lau né bang
vai kho cang sém cang tot.

Néu chét la hodc nwdc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau do lau sach chét la hodc



nwéce rdi glri man hinh dén trung tam
bdo duwéng.

+ Khong cét gitr hodc st dung man hinh
& noi c6 ngudn nhiét, anh nang truc
tiép hodc qua lanh.

« D& duy tri hoat dong téi wu ctia man
hinh va st dung né trong thoi gian dai,
hay dung man hinh & noi nam trong
gi&i han nhiét d va do 4m sau.

* Nhiét d6: 0-40°C 32-95°F
« Do &m: 20-80% RH

« LUU Y: Ludn bat trinh bao vé man
hinh chuyén déng khi ban khéng st
dung man hinh. Ludn bat &ng dung
lam m&i man hinh dinh ky, néu khoéng,
man hinh ctia ban sé& hién thi nhitng
ndi dung tinh khéng thay dbi. Hién thj
lién tuc cac anh tinh trong moét thoi
gian dai c6 thé gay ra hién twong “anh
thtr néng”, con dwoc goi la “anh ao”
hay “anh béng ma”, trén man hinh cla
ban.

«  “Anh thtr néng”, “Anh &o0” hay “Anh
béng ma” la hién twong phd bién trong
c6ng nghé man hinh LCD. Trong hau
hét cac trwong hop, hién twong “anh
thlr ndng” hodc “anh 4o0” hay “anh
béng ma” sé& dan dan bién mat sau
mot thoi gian man hinh bi ngét dién.

) Canh bao

Khéng thé kich hoat trinh bdo vé man hinh
hoac &rng dung nap lai man hinh dinh ky
c6 thé gay ra cac sy cb nghiém trong nhuw
“thtr néng” hodc “anh sau” hoac “anh boéng
ma” von sé& khong biét mat va ciing khong
thé khac phuc. Thiét hai nhw trén khoéng
nam trong chinh sach bao hanh ctia ching
toi.

Dich vu

« Chi nhan vién dich vu chuyén moén
maoi dwoc mé vo boc man hinh.

«  Néu can moi tai lieu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tam dich vu tai

dia phwong ban. (vui long tham khéo
chwong "Trung tdm thong tin tiéu
dung")

+ D& biét thong tin vé viéc van chuyén,
vui I6ng tham khao muc "Théng sé ky
thuat".

« Khoéng dat man hinh trong xe hoi/cdp
xe dwdi anh nang truc tiép.

& Ghichu

Hay tham khao y kién clia k¥ thuat vién
dich vu néu man hinh khéng hoat déng
binh thuwd'ng hodc néu ban khéng chac
phai thwc hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
s6 tay nay.



1.2 M6 ta biéu twong

Cac muc phu sau day mo ta cac quy wéc
ve bieu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bé sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gbm
cac ghi chd, lwu y hodc canh bao. Ching
dwoc str dung nhu sau:

& Ghichu

Biéu twong nay cho biét cac thong tin
quan trong va cac bi quyét gidp ban tan
dung tét hé théng may tinh.

O Lyuy

Biéu twong nay cho biét cac thong tin gitip
ban biét cach tranh dwoc sw cb héng héc
tiém &n déi voi phan clirng hodc mét diy
liéu.

) Canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém an va gilp ban biét cach tranh
dwoc sw cd do.

M6t s6 canh bao co thé xuét hién & nhiéu
dinh dang va co thé khéng di kém mét
biéu twong. Trong nhirng trwdng hop nay,
céach thire trinh bay cu thé clia canh bao
do6 dwoc quy dinh bédi co quan chlrc nang
lién quan.



1.3 Virt bé san pham va vat liéu
doéng goi
Thiét bj dién & dién ti bj virt bd-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste. You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping

off such waste electrical and electronic,
contact your local government office, the
waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that

can be recycled and reused. Specialized
companies can recycle your product to
increase the amount of reusable materials and
to minimize the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make
the packaging easily separable into mono
materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and
economically viable objectives to optimize
the environmental performance of the
organization's product, service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled.
At Philips, end-of-life management primarily
entails participation in national take-back
initiatives and recycling programs whenever
possible, preferably in cooperation with
competitors, which recycle all materials
(products and related packaging material)

in accordance with all Environmental Laws
and taking back program with the contractor
company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://mww.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai dat man hinh

21 Lép dat
El N6i dung g6i hang

=

%%art

PHILIPS

Adapter AC/DC
(dién xoay chidu/mat chiéu)

MHL (tiy chon)
Cap am thanh(tay chon)

VGA (tuy chon)

L e sy
Quan ly cap

DVI (tay chon)

& Ghi chu
Chi nén st dung mau adapter AC/DC:
Philips ADPC1945(244E5QSD/QSW/

QHSD), ADPC1965(244E5QHAD/QHAW)

) Warnings

Do not rip off panel film

El Lap chan dé

1.

D&t man hinh ndm sép trén bé mat
mém min, can than dé tranh lam tray
xwéc hodac héng man hinh.

Gitr chan dé man hinh bang ca hai tay

va lap chat chan de vao try deé.

(1) Gan nhe chan dé vao tru dé cho
dén khi’ch()t cai khép chat vao
chan de.

(2) Dung ngon tay van chat dinh vit
ndm & phia dwdi chan dé va siét
chéat chan dé vao tru dé.




El Két néi véi PC 244E5QHSD:
244E5QSD,244E5QSW:

PHILIPS

PHILIPS

000
aSa B )

T &1 o

© Dau vao ngudn dien AC/DC
© biu vao VGA
© Dbauvao DVI-D © Dau vao ngudn dien AC/DC
O Khda chbng trém Kensington © Dau vao VGA

© Dau vao HDMI
244E5QHAD,244E5QHAW: @ Dau vao HDMI hosic MHL
© Dbau ra am thanh HDMI
/ @ Khda chbng trém Kensington
(7]

PHILIPS

Két néi véi PC

1. Cam chét cap ngudn vao mat sau cla
1 man hinh.

2. T4t may tinh va rat cap ngudn.

5 3. Cam cap tin hiéu man hinh vao 16 cdm
- video & mat sau may tinh.

/) 4. Cam cap nguodn ctia may tinh va cap
@ y nguc“)n cGa man hinh vao 6 cdm dién
(@ gan do.

. . 5. Bat may tinh va man hinh. Néu man
© Dau vao nguon dign AC/DC hinh hién thi hinh anh thi qua trinh cai
© Dau vao VGA dat da hoan tAt.
© Dau vao HDMI
O Diu vao HDMI hodc MHL
© bau ra tai nghe
O Dau vao am thanh
@ Khda chdng trém Kensington



2.2 Str dung man hinh
E Mb ta mat trwéc cha san pham
244E5QSD,244E5QSW,244E5QHSD:

BAT va TAT ngudn man
| .

O O i
Truy nhap menu OSD.

© (&=/0K|Xac nhan diéu chinh menu
OSD.

©®  d |Trdvé mic OSD trudec.

O [ |Déidinh dang hién thi.

© | A V¥ (Chinh menu OSD.

O ©® |Ddingudn vao tin hiéu.
Smartimage Lite. C6 ba
ché dd dé ban Iwa chon:

o @ Standard (Chuén), Internet,
Game.

244E5QHAD,244E5QHAW:

(5]

B/« /v (/A /0K »

U U
e 0 O0 o o

BAT va TAT ngudn man
| .

0 O lym
Truy nhap menu OSD.

® & /0K |Xac nhan diéu chinh menu
OSD.

© 4« |Trdvé mirc OSD trudec.

©® ¢ [Chinh am luvgng loa.

© | A V¥V [Chinh menu OSD.

O © [DPdingudn vao tin hidu.
Smartlmage Lite. C6 ba
ché do dé ban Iya chon:

o @ Standard (Chuén), Internet,
Game.




E1 M6 ta menu Hién thj trén man hinh
Hién thi trén man hinh (OSD) la gi?
Hién thi trén man hinh (OSD) la mét tinh
nang c6é & moi man hinh LCD cua Philips.
N6 cho phép ngudi dung diéu chinh hoat
doéng clia man hinh hodc chon céac chirc
nang ctia man hinh tryc tiép théng qua
mot cira sd huwéng dan hién thi trén man
hinh. M6t giao dién hién thij trén man hinh
dé sir dung duoc thé hién nhw sau:

244E5QSD,244E5QSW:

Hwéng dan co ban va don gian vé cac
nat diéu khién

Trong menu OSD minh hoa & trén, ban cé
thé nhan v A cac nat & g& mét trude cla
man hinh dé di chuyén con tré va nhén nat
OK dé xac nhan lya chon hodc thay déi.

Menu OSD

Duai day la tdng quan vé& co ciu cla
menu Hién thi trén man hinh. Ban co thé
str dung co’ cdu nay lam théng tin tham
khao khi muén thuc hién cac diéu chinh
khac sau nay.

Main menu Sub menu
— Input — VGA
— DVI (available for selective models)

— HDMI (available for selective models)
—— MHL-HDMI (available for selective models)

— Picture r— Picture Format — Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
—— SmartResponse —— Off, Fast, Faster, Fastest
(available for selective models)
— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
(available for selective models)
— Pixel Orbiting — On, Off
(available for selective models)
t— Over Scan — On, Off
L (available for selective models)
— Volume — 0-100
— Audio (available for selective models)
[ Mute — On, Off
L Audio Source ~—— Audioln/HDMI
(available for selective models)
L Color r— Color Temperature ~—— §500K, 9300K
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Deutsch, Espafiol, EAnvikr, Frangais,

Italiano, Maryar, Nederlands, Portugués,
Portugués do Brazil, Polski, Pycckmit Svenska,
Suomi, Tirkge, Cestina, Ykpaincobka, &AL,

SR, AR,
— OSD Settings — Horizontal — 0~100
+—Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time Out — 55, 10s, 20s, 30s, 60s
— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
[ Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Théng bao vé dé phan giai

Man hinh nay dwoc thiét ké dé& hoat
dong téi wu véi dd phan giai gbc 1a
1920%1080@60Hz. Khi dwgc chinh sang
dd phan giai khac, man hinh sé hién thj
mét théng bao: Use 1920%1080@60Hz
for best results. (Hay dung d6 phan giai
1920%x1080@60Hz dé co6 két qua téi wu.)

Ban co thé tat thong bao hién thi d6 phan
gidi goc tir myc Cai dat trong menu OSD
(Hién thi trén man hinh).

B Tinh nang vat ly
Nghiéng




2.3 Gi&i thiéu vé MHL (Lién két
Do nét Cao Di dong)

El Dbay la chirc nang gi?

Lién két D6 nét Cao Di déng (MHL) la giao
dién am thanh/video di dong dé két néi
truc tiép dién thoai di ddng va nhirng thiét
bi di ddng khac v&i cac man hinh dd nét
cao.

Cap MHL tuy chon cho phép ban chi can
két ndi thiét bi di dong twong thich MHL
v&i man hinh Ién MHL Philips nay, va xem
cac video HD gidng nhw that v&i am thanh
ky thuat s6 hoan chinh. Gi& ban khéng chi
c6 thé tan hwéng cac game di dong, anh
chup, phim, hoac cac rng dung khac trén
man hinh I&n cla Philips ma con c6 thé
sac pin ddng thdi cho thiét b di dong dé
ban khéng bao gi¢&r hét pin gitra chirng.

El Lam thé nao dé str dung chirc ning
MHL?

P& stv dung chirc nang MHL, ban can ¢
thiét bj di dong dwoc chirng nhan twong
thich MHL. Dé tim danh séach cac thiét bi
dwoc chirng nhan twong thich MHL, hay
truy cép trang web MHL chinh thirc (http://
www.mhlconsortium.org)

Ban ciing can co cap tuy chon dac biét
duwoc chirng nhan twong thich MHL dé st
dung chrc nang nay.

El Chirc ning nay hoat dong nhw thé
nao? (cach két néi?)

Hay cdm cap MHL tiy chon vao céng USB
mini trén canh thiét bi di dong va cbng
dwoc danh dau [MHL-HDMI] trén canh
man hinh. Gi® ban sin sang xem cac hinh
anh trén man hinh I&n ctia minh va thuc
hién moi chirc nang trén thiét bj di dong
nhw lwét web, choi game, duyét xem anh
chup, v.v... Néu man hinh co chirc nang
loa, thi ban cling c6 thé nghe am thanh
kém theo. Khi ngét két ni cap MHL hoac

10

tat thiét bi di dong, thi chirc ndng MHL
ciing sé tw dong tat theo

PHILIPS

(= @awsen ) MHL-HDMI
T~

=
.

....E{H

& Ghi chu

«  Cbng dwoc danh dau [MHL-HDMI] 1a
cbng duy nhat trén man hinh vén hé
tror chire nang MHL khi str dung cap
MHL. Lwu y rang cap dwoc chirng
nhan twong thich MHL sé khac so voi
cap HDMI chuan.

+ Ban phai mua riéng thiét bi di dong
dwoc chirng nhan twong thich MHL

«  Ban c6 thé phai chuy&n man hinh
theo cach thd cong sang ché d6 MHL-
HDMI dé kich hoat man hinh néu c6
nhirng thiét bi khac dang s&n sang
hoat déng va dwoc két ndi véi cac dau
vao c6 sén

«  Ché do cho/Tét tiét kiem nang lwong
ErP khdng ap dung cho chirc nang sac
pin MHL

* Man hinh Philips nay dwgc chirng
nhan twong thich MHL. Tuy nhién,
trong trwong hop thiét bi MHL cla ban
khong két néi hodc hoat déng thich
hop, hay kiém tra phan Hoi Dap vé
thiét bi MHL hoac lién hé truc tiép voi
nha cung cap dé dwoc hwdng dan.
Chinh sach ctia nha san xuét thiét bi
cta ban cé thé yéu cau ban mua cap
hoac adapter MHL riéng mang thuong
hiéu ctia ho dé co thé st dung thich
hop.



3. T6i wu héa hinh anh

3.1 Smartlmage Lite

E Do lagi?

Smartimage Lite cung c&p cac chirc nang
cai dat s8n giGp ban t6i wu hdéa man hinh
dé str dung cho cac kiéu ndi dung khac
nhau, linh hoat chinh dé sang, doé twong
phan, mau sic va dd sic nét khi str dung
thwe té. DU 1am viéc véi cac ting dung
béng chi, hién thi hinh anh hay xem
video, Philips Smartimage Lite cling mang
lai cho ban hiéu qua man hinh t&i wu nhét.

E Sao tbi phai can n6?

Ban mudn mdt man hinh hién thj téi wu
moi kiéu néi dung wa thich, phdn mém
Smartimage Lite sé linh hoat chinh do
sang, do twong phan, mau sac va do sac
nét khi st dung thuwc t& nhdm nang cao
trai nghiém xem man hinh cda ban.

El Cach hoat déng?

Smartlmage Lite la cong nghé déc quyén
tién tién cta Philips vdn sé phan tich cac
ndi dung hién thi trém man hinh cla ban.
Dwa trén bdi canh str dung ma ban lya
chon, Smartimage Lite sé linh hoat cai tién
dé twong phan, bdo hda mau sac va do
s&c nét clia hinh &nh dé cai thién ndi dung
dang hién thj - t&t ca khi st dung thuc té
chi v&i duy nhat mét cd nhan nat.

El Cach bat chire ndang Smartimage Lite?

1. Nhén BD dé khoi dong Smartimage
Lite trén man hinh;
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2. Tiép tuc nhan BD dé chuyén gitra
Standard (Chuén), Internet, Game.

3. Menu OSD Smartimage Lite s& van
hién thi trén man hinh trong 5 giay
hoac ban ciing c6 thé nhan OK dé xac
nhan lwa chon.

4. Khi Smartlmage Lite da dwoc bat, bd
cuc sRGB sé tw dong tat. D& dung
sRGB, ban phal tat Smartlmage Lite
bang nut e g& mat trwdc clia man
hinh.

Néu khong dung nat B dé& cudn xubng,

ban ciing c6 thé nhan cac nit v a dé& chon

va nhén nut OK dé xac nhan lya chon va
dong menu OSD Smartimage Lite.

Co ba ché do dé ban Iwa chon: Standard
(Chuan), Internet va Game.

@ SmartImage™

Standard

* Standard (Chuan) Lam r6 chir va
gidm do sang giup ban dé doc chiy va
bt moi mat. Che do nay tang dang ké
sy ro rang cla ndi dung chi va hiéu
suét khi ban lam viéc véi cac bang
tinh, file PDF, cac bai muc scan hoac
cac L’mg dung van phong khac noi
chung.

¢ Internet: Cau hinh nay két hop bao
hoa mau sac, linh hoat tang do twong
phan va sac nét dé hién thj anh chup
va cac hinh anh khac véi do ré noi bat
cung mau séc song dong - tat ca moi
thtr ma khdng hé co dau vét ctia mau
sac nhat va gia tao.

» Game: Tang mach truyén dong dé co
thdi gian dap tng toi wu, gidam cac
b& 1€ gai goc cho cac doi twong di
chuyén nhanh trén man hinh, tang dé
twong phan cho bd cuc sang va toi,
cau hinh nay mang lai cho nguw&i choi
trai nghiém choi game tét nhét.



3.2 SmartContrast

K Do lagi?

Céng nghé ddc dao von linh hoat phan
tich néi dung hién thi va tw dong toi wu
hoéa ty lé twong phan cta man hinh LCD
dé mang lai d6 ré nét va trai nghiém xem
ti wu, tang mirc dén nén dé hién thi
nhung hinh &nh sang rd hon, sac nét hon
va song dong hon hay gidm mirc dén nén
@& hién thi rd hinh anh trén phéng nén téi.

El Sao t6i phai can n6?

Ban mudn hién thi ndi dung rd nét cung
cam giac thodi mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chinh
dd twong phan va mirc den nén dé hién
thi nhirng hinh anh choj game hay video
cwc ro, song dong va sac nét hay hién thi
ndi dung chi ro rang dé doc cho céc rng
dung van phong. Bang céach glam viéc tieu
thu dién ctia man hinh, ban sé tiét kiém
dworc chi phi nang Iwcmg va kéo dai tudi
tho cho man hinh ctia ban.

El Cach hoat déng?

Khi ban bat ché dd SmartContrast, n6 sé&
phan tjch ndi dung dang hién thj trong
thuc té dé chinh mau sac va mat do dén
nén. Chtrc ndng nay sé linh hoat tang
do twong phan dé mang lai cho ban trai
nghiém giadi tri tuyét v&i khi xem video
hoac choi game.

3.3 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i cta
Phillips cho phép ban diéu khién man hinh
qua giao dién d6 hoa 3o tién dung Céac
didu chinh phtrc tap 1a nhirng gi thudc vé
qua khtv vi phdn mém than thién véi nguoi
dung nay sé hu’c'yng dan ban qua viéc tay
chinh d6 phan giéi, hiéu chinh mau, didu
chinh ddng hé/géc pha, diéu chinh diém
trdng RGB (Pd-Luc-Lam), v.v..

Trang bi céng nghé méi nhéat vé thuat toan
I6i xt ly va phan ¢ng nhanh, phan mém
chay bang anh déng bat méat thwong thich
vé&i Windows 7 ndy san sang nang cao trai
nghiém ctia ban vé&i man hinh Philips!
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Kl Cai dat . )

e Thuwc hién theo chi dan va hoan tat
quy trinh cai dat. . .

+ Ban co6 thé khéi dong phan mém sau
khi hoan tat cai dat.

+ Néu mubdn kh&i dong sau, ban cé thé
click phlm t4t phan mém frén man
hinh nén hodc thanh céng cu may
tinh.

PHILIPS v i o e

Thuat si khé&i dong lan dau

« Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé tw dong vao
Thuét sT khéi dong lan dau.

* Thuét sT nay sé huwong dan ban thong
qua viéc didu chinh tirng bwéc vé& hiéu
suat man hinh.

+ Sau nay ban cling c6 th& vao menu
Plug-in (B6 sung) dé bat thuat si.

« Ban c6 thé chinh cac tiy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.

SmartControl Lite

PHILIPS

&
=
L5

Optone

\ﬁ .

la fEeid .



E Khéi dong bang giao Standard (dién Wi mx
Chuan): SmartControl Lite PHILIPS

Menu Adjust (Diéu chinh):
+  Menu Adjust (Bidu chinh) cho phép ‘ U

ban chinh Brightness (D6 sang),
Contrast (B¢ twong phan), Focus

(Trong tdm), Position (Vi tri) va ' -
Resolution (D6 phan gii). = 2B e 0 &
- Ban co thé lam theo chi dan va thyc g . - :
hién diéu chinh. poe— ;: roo Nessemn
+ Lénh Cancel (Hay) s& hdi nguwdi ding Q o
xem ho c6 mudn hay tién trinh cai dat =
hay khéng.
[ pe— 2o
SmartControl Lite PHILIPS B sl B
SmartControl Lite PHILIPS

Postion

[ e [Hx
SmartControl Lite PHILIPS [ P i
Contrast SmartControl Lite PHILIPS

esolution
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Menu Color (Mau):

Menu Color (Mau) cho phép ban chinh

mau RGB (Dé-Luc-Lam), Black Level
(Do t6i), White Point (Diém tréng),
Color Calibration (Hiéu chinh mau) va
Smartimage Lite (Vui ldbng tham khao
muc Smartimage Lite).

Ban co thé 1am theo chi dan va thuc
hién diéu chinh.

Tham thao bang bén dudi dé hinh
dung co ban vé muc menu phu trén
théng tin nhap cua ban.

Vi du Color Calibration (Hiéu chinh
mau sac):

[

SmartControl Lite

[

SmartControl Lite

[
PHILIPS

Bk Level

st ek Lirwed ol rmnat o s of
et the Mlack Lol §

[
PHILIPS

White Pomnt

i
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SmartControl Lite

p—— 7

PHILIPS

Uisplay Gamma

e
e

[

SmartControl Lite

[
PHILIPS

Calibration

- .
K.
= -
- =

. "Show Me" (Cho t6i xem) sé bat

hwéng dan hiéu chinh mau.

. Start (Bat ddu) - bat dau quy trinh

canh chinh mau qua 6 buwéc.

. Quick View (Xem nhanh) tai cac hinh

anh trwdc/sau.

. Tré vé giao dién chinh Color (Mau),

click nut Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwgc
bat. Néu khéng chon muc nay, ban
khong dwoc phép hiéu chinh mau va
tat cac nut khéi ddong va xem nhanh.
Phai c6 théng tin bing sang ché trén
man hinh hiéu chinh.



Man hinh hiéu chinh mau dau tién:

« Nut Previous (Trwéc) sé tat cho dén
khi man hinh mau th& hai bat 1én.

* Next (Ké tiép) s& chuyén vao muc tiéu
tiep theo (6 muc tiéu).

+ K& tiép cudi cuing sé& vao giao dién
File>Presets (File>Cai san).

* Nut Cancel (Hay) sé déng giao dién
ngwoi dung (Ul) va tré vé trang Plug-
in (bd sung).

Smartimage Lite

Cho phép nguoi dung thay ddi cai dat dé

dat mtre cai dat man hinh tét hon dwa vao

néi dung.

Khi da cai dat Entertainment (Giai tri), tinh

néng SmartContrast va SmartResponse

sé tat.
B e e

SmartControl Lite PHILIPS

Smartimage

i t3

15

Options>Preferences (Tuy chon>Uu tién)

- Sé chi hoat dong khi chon Preferences

(Uu tién) tr menu Options (Tuy chon) s

xudng. Trén man hinh khéng hé tro twong

thich v&i chuan DDC/CI, chi c6 s&n cac

thé Help (Trg giup) va Options (Tuy chon).
B Settrns 7

SmartControl Lite PHILIPS

&
=
LY

e -

Hel)

+ Hién thi cac cai dat wu tién hién hanh.

+ O vira chon sé bat tinh nang nay. O
chon la nat bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Menu
Enable Context (Bat thudc tinh) hién
thi cac lwa chon SmartControl Lite cho
Select Preset (Chon cai sén) va Tune
Display (Chinh man hinh) trong menu
thudc tinh khi click phai vao man
hinh nén. Disabled (Da tét) s& xéa
SmartControl Lite khdi menu thudc
tinh click phai.

+ Biéu twong Enable Task Tray (Bat

khay tac vu) dwoc chon la (Bat) theo
mac dinh. Enable Context Menu
(Menu bat thudc tinh) hién thi menu
khay tac vu cho SmartControl Lite.
Click phai vao biéu twong khay tac

vu s& hién thj cac tiy chon menu cho
Help (Tro giup), Technical Support
(H6 tror ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi d& tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khong
bat khi khéi dong hodc ndm trong
khay tac vu. Cach duy nhét dé bat
SmartControl Lite 1a tlr phim tat trén
man hinh nén hoéc ti file chuwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khéng tai khi 6 nay khong dwogc chon
(D4 tat).

« Enable transparency mode (Bat ché
dd trong subt) (Windows 7, Vista, XP).
Mac dinh Ia 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé chi

hoat ddng khi chon Input (Nh&p) tr menu

Options (Tuy chon) s6 xuéng. Trén man

hinh khéng hé tre twong thich véi chuan

DDCI/CI, chi c6 sén céc thé Help (Tro

gitip) va Options (Tuy chon). TAt ca cac

thé SmartControl Lite khac déu khéng co
san.
[ prrie—" (il
SmartControl Lite PHILIPS

e

=
=
&y

=1
et

a i g ie

Ay I

« Hién ‘thj giao dién hu’é’qg dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

* Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thj.
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Options>Audio (Tuy chon>Am thanh)
- Sé chi hoat dong khi chon Audio (Am
thanh) t&» menu Options (Tuy chon) s
xubng.

Trén man hinh khéng hé tro twong thich
véi chudn DDC/CI, chi ¢ sdn cac thé Help
(Tro giup) va Options (Tuy chon).

B sicirenl T

SmartControl Lite PHILIPS

=
=

- e

C

‘4

L

Help

Help>User Manual (Tro’ gitip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (Sb tay st dung) t& menu Help
(Tro gitp) sb xubng. Trén man hinh khéng
hé tro twong thich véi chudn DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options
(Tuy chon).
B sicirenl T

SmartControl Lite PHILIPS

User Manual

it ieiefe =

=
=
4
-/



Help>Version (Tro giip>Phién ban) -
Sé chi hoat dong khi chon Version (Phién
ban) t&r menu Help (Tro gitp) s xudng.
Trén man hinh khéng hé tro' twong thich
v&i chuan DDC/CI, chi c6 sén cac thé Help
(Tro giup) va Options (Tuy chon).

e i

SmartControl Lite PHILIPS

-
(- Y
@

Context Sensitive menu
(Menu nhay cam vé&i thudc tinh)

Theo mac dinh, menu Context Sensitive
(Chinh theo thudc tinh) sé& dwoc Bat. Néu
da chon menu Enable Context (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>UWu tién) thi menu nay sé hién
thi.

g SmartControl

Select Preset L4

The Context Menu (Menu thudc tinh) c6
bon muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thj.

+ Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai sén da
lwu theo trinh tw d& s dung ngay.
DAu kiém sé& hién thi muc cai s&n hién
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da chon. Muc Factory Preset (Cai sdn
gdc) ciing co thé duoc chon tir menu
s6 xubng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+  Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

ba bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
béng cach click phai vao biéu twong
SmartControl Lite tiv khay tac vu. Click trai
sé bat rng dung.

Help

Technical Suppart
Check For Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy cap file User
Manual (S0 tay st dung): M¢& file User
Manual (S tay str dung) qua clra sO
trinh duyét mac dinh.

+ Technical Support (H6 trg’ ky thuat) -
hién thj trang ho tro’ ky thuat.

+  Check for Update (Kiém tra cap nhat)
- dan nguwoi dung dén Nén ng dung
PDI va kiém tra phién ban cta nguoi
dung so voi phién ban c6 san méi
nhat.

+ About (V&) - Hién thj thong tin tham
khao chi tiet: phién ban san pham,
thong tin vé phién ban va tén san
pham.

» Exit (Thoat) - BPong SmartControl Lite.

D& chay lai SmartControl Lite, hdy chon
SmartControl Lite t* menu Program
(Chwong trinh), click doi bidu twong PC
trén man hinh nén hoac khéi déng lai hé
théng.



PHILIPS

SmartControl

B

Wersion 3,20
dtune~standard-fC0T-01 -0 115123
Copyright 1083 2007 Portra Displiys, e,
Paterts Pandng

P4 tat menu khay tac vu

Khi da tat Khay tac vu trong thu muc

wu tién, chi con cé san lwa chon EXIT
(THOAT). B& x6a hoan toan SmartControl
Lite khéi khay tac vu, hay tat Run at
Startup (Chay khi kh&i déng) trong
Options>Preferences (Tuy chon>Uu tién).

@quy

Tét ca cac hinh minh hoa trong phan
nay chi dwgc dung dé& tham khao. Chiing
t6i c6 thé thay ddi phién ban phan mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cép trang web
chinh thirc clia Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé& phién
ban phan mém SmartControl mé&i nhét.
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4. Cac théng so6 ky thuat

Loai mat man hinh

Man hinh LCD AH-IPS

Deén nén LED

C& man hinh Roéng 23.8 inch (60,5cm)
Hé sé co 16:9

Do pixel 0,2745 x 0,2745 mm

Do sang 250 cd/m?
SmartContrast 20.000.000:1

Do twong phan (chuan) 1000:1

Thoi gian dap (ing (chuén) 14 ms (mili giay)

Phan &rng thong minh

SmartRegponsg 2 (Ee)

D6 phan giai toi wu 1920x1080 @ 60Hz
Goéc xem 178° (H)/178° (V) @ C/R > 10

Cai tién hinh anh

Smartimage Lite

Mau man hinh

16,7 triéu mau

DAu vao tin hiéu

Tbc do phat doc 56Hz - 76Hz
Tan sb ngang 30kHz - 83kHz
MHL 1080P@30Hz
SsRGB (Dd-Luc-Lam chudn) | CO

244E5QSD,244E5QSW: VGA (Analog), DVI (KTS
HDCP)

244E5QHAD,244E5QHAW,244E5QHSD: VGA (Analog),
HDMI (KTS ,HDCP), MHL-HDMI (KTS ,HDCP)

DAu ra/vao am thanh

244E5QHAD,244E5QHAW : Dau vao am thanh PC, dau
ra tai nghe
244E5QHSD: PAu ra am thanh HDMI

Tin hiéu vao

Ddng bo riéng, Bdng bd véi tin hiéu xanh luc

Tién ich

Tién ich cho nguwdi dung

244E5QSD,244E5QSW,244E5QHSD:

ED/« /v /A /0K 0)
244E5QHAD,244E5QHAW:
&/« /v 10/A B8/0K 0)

Ngén ngi» OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Brc, Tiéng Tay Ban Nha, Tiéng Hy Lap,
Tiéng Phap, Tiéng Y, Tiéng Hungary, Tiéng Ha Lan, Tiéng
Bb Dao Nha, Tiéng Bd Pao Nha Brazil, Tiéng Ba Lan,
Tiéng Nga, Tiéng Thuy Dién, Tiéng Phan Lan, Tiéng Thb
Nhi Ky, Tiéng Séc, Tiéng Ukrana, Tiéng Hoa gian thé,
Tiéng Hoa phdn thé, Tiéng Nhat, Tiéng Han
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Tién ich khac

Khéa Kensington

Twong thich véi chuén Plug
& Play (C&m vao |a phat)

DDC/CI, sRGB, Windows 8/7/Vista/XP, Mac OSX, Linux

Nghiéng -5°/ +20°

244E5QSD,244E5QSW:
Ché d bat 24,0 W (chuén), 25,5 W (tbi da)
Ché d6 chd (chuén) 0,5W
TAt (chuan) 0,3W

DPén bao LED ngudn

Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)

B6 ngudn

Ngoai vi, 100-240VAC, 50-60Hz

244E5QHAD,244E5QHAW:

Ché d bat 25,2 W (chuén), 33,8 W (tbi da)
Ché dd cho (chuén) 0,5W
TAt (chuan) 0,3W

Dén bao LED ngudn

Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)

B& ngudn Ngoai vi, 100-240VAC, 50-60Hz
244E5QHSD:
Ché db bat 24,2 W (chudn), 26,1 W (t6i da)
Ché do cho (chuan) 0,5W
Tat (chuan) 0,3W
Dén bao LED ngudn Ché dd bat: Ché dd Trang, Chd/Ngu: Tréng (nhap nhay)
B6 ngudn Ngoai vi, 100-240VAC, 50-60Hz

San pham kém theo dé gitr
(Réng x cao x day)

557 x 428 x 213 mm

Sén pham khong kém theo
dé gilr (Rdng x cao x day)
Trong lwong

557 x 338 x 45 mm

San pham kém theo dé gitv | 3,800 kg
S?n .eham khéng kém theo 3,440 kg
deé qgitr

San pham déng goi 5,341 kg

Diéu kién hoat dong
Pham vi nhiét d6 (hoat dong)

0°C-40°C
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Gidi han nhiét do

binh gitra cac sw cb)

(Khéng hoat dong) PGS
Do am twong déi 20% - 80%
MTBF (Thoi lwong trung 30.000 giov

Chi thi ROHS (Gi¢i han cac

chat gay hai) €9
EPEAT Bac (www.epeat.net)
Thung dwng Co thé tai ché 100%

Cac chét cu thé

Thung dwng 100% khong chira PVC BFR

Ngbi sao nang luvong
Tuan tha va tiéu chuan

Phé chuén theo quy dinh

Mau

CO

CE Mark, FCC Class B, CU, SEMKO, TCO Certified,
ETL, BSMI, 1IS09241-307

244E5QSW, 244E5QHAW: Tréng/244E5QSD,
244E5QHSD, 244E5QHAD: Mau den dé anh dao hoac
cac tuy chon mau khac nhw ap dung tai khu virc clia ban

L&p son ngoai

Bong lang/Hoa van

€ Ghichu

1. Vang hay bac EPEAT chi c6 hiéu lwc tai noi ma Philips da d&ng ky san pham. Hay truy
cap www.epeat.net dé biét fnh trang dang ku tai qudc gia cta ban.

n

Dt liéu nay chiu sy thay ddi ma khéng can thdng bao truéc. Truy cap www.philips.com/

support dé tai v& phién ban td roi méi nhét.

w

. Thoi gian phan (rng théng minh 1a gia tri ti wu tlr cac thir nghiém GtG hodc GTG (BW).



4.1 Ché do dé phan giai & cai
dat san
E D6 phan giai toida
1920x1080@60 Hz (d4u vao analog)
1920x1080@60 Hz (d4u vao KTS)
E1 D6 phan giai khuyén dung
1920x1080@60 Hz (d4u vao KTS)

Tansd D6 phangidi Tan sb doc

ngang (kHz) (Hz)
31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

63,89 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghichu

Lwu y réng man hinh cla ban hoat

dong tét nhat & d6 phan giai goc
1920%1080@60Hz. D& co6 chét lwong hién
thi tt nhat, hay dung dd phan giai khuyén
nghi nay.
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5. Quan ly nguén dién

Cai dat sau day dwoc dung dé do mutrc
tiéu thu dién trén man hinh.

Néu ban da cai dat card man hinh hay « Do phan giai gbc: 1920x1080

phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw dong gidm
tiéu thu dién khi khéng str dung. Néu phat

+ Do twong phan: 50%
» D06 sang: 250 nit

hién nhap tlr ban phim, chuét hay thiét bi * Nhiét d6 mau: 6500k voi kiéu mau
nhap khac, man hinh sé "boat dong" ty trang day du
dong. Bang sau day sé hién thj mc tiéu © Ghi chu

thu dién va cach truyén tin hiéu cla tinh

nang tiét kiem dién tw déng nay:

D@ liéu nay chiu sw thay ddi ma khong
can théng bao trudrc.

244E5QSD,244E5QSW:

Dinh nghia quan ly nguén dién
ChEdd |\/4e0 Dggg Ddng | Ngudn dién siv | Mau den
VESA nga'ng b6 doc dung LED

Hoat dong| BAT | C6 | C6 2245'%‘0’\/(&2;’:2)) Tréng

Tréng

Ngu TAT [Khéng|Khéng| 0,5W (chuan) | (Nhap

nhay)

Tit | TAT 0,3 W (chu&n) | TAT
244E5QHAD,244E5QHAW:

Dinh nghia quan ly nguén dién
ChE a0 |\/100 Dggg Pdng | Ngudn dién s | Mau den
VESA nga'ng bé doc dung LED

Hoat dong| BAT | co | co 2353%"\,\’/(&2;’;2)) Tring

Tréng

Ngu TAT |Khéng|Khéng| 0,5W (chuan) | (Nhap

nhay)

Tét | TAT 0,3 W (chu&n) | TAT
244E5QHSD:

Dinh nghia quan ly ngudn dién

ChE a0 |\/i100 ngg Dbdng | Ngudn dién s | Mau den
VESA * |bd doc dung LED
ngang
N ; .| 24,2 W (chuén) <
Hoat dong| BAT | Co Co 26.1 W (t5i da) Trang
. Tréng
Ngu TAT [Khéng|Khéng| 0,5W (chuan) | (Nhap
nhay)
Tit | TAT 0,3W (chuén) | TAT
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery

y and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable [T - manufacture,
use and recycling of IT products

reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:
*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO

Certified Displays:

e Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[u Technology for you and the planet
CERTIFIED

(Only for selective models)




EPEAT

(www.epeat.net)
%  The EPEAT (Electronic

Product Environmental

C 7 Assessment Tool) program

evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

* EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

e 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing

organization on 1SO9000 level.

* 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2011 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product

rerfi meets the ENERGY STAR?

guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'€quipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This device belongs to catagory B devicas as described in EM 55022, unless it is spacif-
cally stated that it is a Class A devios on the spscification labsl. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 maters). The user of the
davics is obligad to take all staps necessary to remove sources of interferance to tele-
communication or ather devicas.

Pokud nenf na typovém Biitku pofétate uvedeno, 28 spadé do do tiidy A podie EN 55022,
spada automaticky do tficy B podie EN 55022, Pro zafizeni zafazend do tfidy A (chranné
pésma 30m) podie EN 55022 plati nésledujici Dojde-ll k rulianf tslekomunikadnich nebo
Jinjch zafizeni je utivatel povinnen provést takovd opatfgni, aby nuSeni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZHARER2RE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerédtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy dinh

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

e e

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh man
hinh phéng cuta Philips

Philips ¢6 gang cung cap cac san pham
chét lwong cao nhat. Chang t6i ap dung
moét s6 quy trinh sdn xuat tién tién nhat,
trong Iinh vire va thwe hién quy trinh kiém
tra chat Iqqng nghiém Qgét. Tuy nhién,
cac I6i diém anh hay diém anh con trén
man hinh TFT dung trong cac man hinh
phang ddi khi khong the tranh khoi. Khong
nha san xuéat nao cé thé dam bao rang
moi man hinh s& khong c6 cac 16i diém
anh, nhung Philips dam bao rang bat ky
man hinh nao cé mét so 16i khéng thé
chap nhan sé dwoc stra chira hodc thay
m¢&i dwa vao chinh sach bao hanh. Thong
bao nay giai thich nhitng kiéu I8i dlem anh
khac nhau va dinh nghfa cac mirc, 16i co
th& chap nhan cho méi kiéu 16i. Dé hwéng
dich vu stra chira hay thay_ thé theo chinh
sach bao hanh, sé lwong 18i diém anh trén
man hinh TFT phal vuwot qua cac mire
chép nhan nay. Vi dy, khong qua 0,0004%
diém anh con trén man hinh cé thé bj I8i.
Ngoai ra, Philips tham con dat ra cac tiéu
chuan chat lwong cao hon cho mot sb
kiéu hay két hop 16i diém &nh vén dé nhin
thay hon cac kiéu 16i khac. Chinh sach
nay cé hiéu luc trén toan cau.

subpixel

RGB[W

pixel

Diém anh va diém anh con

Diém anh hay phan tlr anh gdm ba diém
anh con trongkcac mau chinh dé, luc va
lam. Nhiéu diém anh cung tao thanh hinh
anh. Khi moi diém anh con cGa mot diém
anh sang Ien ba diém anh con c6 mau
sac cing hién thi nhw mot diém anh trang
don I1&. Khi moi diém anh con téi me, ba

diém anh con c6 mau sac cung hién thi
nhu mot diém anh den don Ig. Nhirng, két
hop diém anh_con sang va tbi khac hién
thi nhw cac diém anh don 1 tir nhitng
mau khac.

Cac kiéu 16i diém anh
Céc 16i diém anh va diém anh con hién
thi trén man hinh theo nhitng cach khac

nhau. C6 hai kiéu 16i diém anh va nhiéu 16i
diém anh con trong méi kiéu I6i.

Cac 16i cham sang

Céc 16i chdm séang hién thj dwgi dang cac
diém anh hay diém anh con vén luén sang
hay "bat". Nghia la mbi cham sang la mot
diém anh con von ndi I&n trén man hinh
khi man hinh hién thj kiéu hinh tbi m¢. Cé
cac kidu 16i chdm sang.

Mot diém anh con sang dd, luc hay lam.

¢

Hai diém anh con sang gan nhau:

- Do+ Lam=Tim

- Do + Luc = Vang

- Luc + Lam = Luyc lam (Lam nhat)

Ba diém anh con sang gan nhau (mét
diém anh tréng).
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& Ghi chu

Chém sang dé hay lam phéi sang hon
50% so v&i cac chdm xung quanh trong
khi ché'm sang luc sang hon 30% so voi
cac cham xung quanh.

Cac 16i cham den

Céc I16i cham den hién thj dwdi dang cac
diém anh hay diém anh con vén luén téi
mo hay 't&t'. Nghia la méi chdm t6i mo 1a
mdt diém anh con vén ndi 1én trén man

hinh khi man hinh hién thj kiéu hinh sang.

Co céac kiéu 18i chdm den.

LOI CHAM SANG

Do gan cua céc 16i diém anh

Vi cac 16i diém anh va diém anh con cla
cung kiéu 16 vén gan véi mot kiéu 16i khac
c6 thé dé nhin thay hon, Philips ciing néu
ré cac dung sai vé do gan cda I6i diém
anh.

Dung sai 16i diém anh

D& hwéng dich vu sra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phéng Philips phai cé cac 16i diém anh hay
diém anh con vwot qua nhitng dung sai
néu trong cac bang sau.

MUC CHAP NHAN

1 diém anh con sang 3

2 diém anh con sang gan nhau 1

3 diém anh con sang gan nhau (mét diém anh tréng) 0
Khoang cach gitra hai I6i chdm sang* >15mm
Tbng sb 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM BEN MUC CHAP NHAN
1 diém anh con t&i mo 5 hoac it hon
2 diém anh con t6i m& gan nhau 2 hoéc it hon
3 diém anh con t6i m& gan nhau 0
Khoang cach gitva hai I6i chAm den* >15mm
Téng s6 16i chdm den clia moi kiéu I5i 5 hodc it hon

TONG SO LOI CHAM

Tbng s 16i cham sang hay den ctia moi kiéu I6i

MUC CHAP NHAN
5 hoac it hon

& Ghichu

1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chdm

2. Man hinh nay tuan thd chuan 1ISO 9241-307. (1S09241-307: Yéu cu, phan tich vé hiéu
nang va cac phwong phap kiém tra tuan tht cho man hinh dién tc)



7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 thdng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vuc ctia ban, vui ldng truy cap website www.philips.com/support. Ban cling c6 thé lién
hé v&i Trung tdm cham soc khach hang dia phwong clia Philips theo sb dién thoai dwdi
day.

Théng tin lién lac cho khu vwc TAY AU:

Quéc gia

S BT dwdng day

Gio hoat dong

nong

Austria RTS +43 0810 000206 €007 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €006 Mon to Fri: 9am - 6pm
Cyprus Alman 800 92 256 Free of charge |Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff | Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853 € 0.09 Mon to Fri:9am - é6pm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
Italy Anovo ltaly +39 840 320 041 €0.08 Mon to Fri: 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 (€ 0.10 Mon to Fri: 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri:9am - 6pm
Switzerland ANOVO CH |+41 02 2310 2116 Local call tariff | Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Théng tin lién lac cho khu viec CHAU MY LATINH:

Quéc gia

Trung tam dich vu

S6 cham séc khach hang

Brazil

Argentina

Vermont

0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

S6 cham séc khach hang
4008 800 008

Quéc gia
China

Trung tam dich vu
PCCW Limited
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Thoéng tin lién lac cho khu viec TRUNG VA BONG AU:

Quéc gia LLCLRE Ao . .
dich vu CSP So cham so6c khach hang

+375 17 217 3386
Belarus N/A IBA +37517 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

+372 6519900(General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71

+36 1 814 8080(General)
Hungary N/A Profi Service +36 1814 8565(For AOC&Philips only)
Kazakhstan N/A Classic Service ll.c. | +7 727 3097515

+371 67460399
Latvia N/A ServiceNet LV +371 27260399

+370 37 400160(general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC Hand +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Théng tin lién lac cho khu viec NAM MY:

Quéc gia  Trung tam dich vu S6 cham séc khach hang
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800)479-6696
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Thong tin lién lac cho khu virc Chau A TBD/Trung Déng/Chau Phi (APMEA):
S6 cham séc khach

Quéc gia Gid hoat dong

hang
Armenia
Azerbaijan N ;
Georgia Firebird service centre +97 14 8837911 ?;%OThu. 09:00 -
Kyrgyzstan '
Tajikistan
Australia AGOS NETWORK PTY LTD 1300 360 386 ?ggp;f” 7:00am-
Hong Kong: 24 G
Hong Kong | Company: Smart Pixels Technology | Tel: +852 2619 9639 Mon. ~Fri, 9:00am-
6:00pm
Macau Ltd. Macau: Sat 9:00am-1:00
Tel: (853)-0800-987 at 7ibam-Topm
: Tel: 1 800 425 6396 Mon.~Fri. 9:00am-
india REDINGTON INDIALTD SMS: PHILIPS to 56677 | 5:30pm
+62-21-4080-9086 Mon.~Thu. 08:30-
Indonesia PT. CORMIC SERVISINDO (Customer Hotline) 12:00; 13:00-17:30
PERKASA +62-8888-01-9086 Fri. 08:30-11:30;
(Customer Hotline) 13:00-17:30
lsrael Eastronics LTD 1-800-567000 sun~Thu. 08:00-
18:00
Mon.~Fri. 9:00am-
Korea Alphascan Displays, Inc 1661-5003 5:30pm

Sat. 9:00am-1:00pm

Mon.~Fri. 8:15am-
Malaysia R-Logic Sdn Bhd +603 5102 3336 5:00pm
Sat. 8:30am-12:30am

Mon.~Fri. 8:30am-

New Zealand | Visual Group Ltd. 0800 657447
5:30pm
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-
6:00pm
I EA Global Supply Chain Solutions : Mon.~Fri.
Philippines nc. (02) 655-7777; 6359456 8:30am~5:30pm
Philips Electronics Singapore Mon.~Fri. 9:00am-
Singapore Pte Ltd (Philips Consumer Care (65) 6882 3966 6:00pm
Center) Sat. 9:00am-1:00pm
South Africa | Computer Repair Technologies 011 262 3586 Mon.~ Fri
P P g 08:00am~05:00pm
Taiwan FETEC.CO 0800-231-099 :48‘?&';”" 09:00 -
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8. Khac phuc sw co &
Hoi Dap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw ¢ vén nguoi
dung cé thé khéc phuc. Néu sw cb van
tiép dién sau khi ban da thr dung cac giai
phéap trén trang nay, hay lién hé véi dai
dién dich vu khach hang cta Philips.

El Cac sw cb thwong gap

Khéng c6 hinh anh (Pén LED ngudén

khéng sang)

+ Dam bao da cam day ngudn vao 6
cam dién va mat sau ctia man hinh.

«  Trwdce tién, ddm bao nut ngudn &
mét tredc man hinh nam & vi tri OFF
(TAT), sau d6 day nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Pén LED nguén

sang trang)

*  Dam bdo da bat may tinh.

«  DPam bao cap tin hiéu da dwoc két nbi
duang céach véi may tinh clia ban.

+ Dam bao cap man hinh khéng c6 cac
ch’éu cam bj cong trén mat két noi.
Néu co, hay stra hay thay méi cap.

« C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh théong bao

Attention

Check cable connection

«  Dam bao cap man hinh da dwoc két
ndi ding cach véi may tinh cla ban.
(Ciing tham khao Huéng dan khéi
doéng nhanh).
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+  Kiém tra xem cap man hinh cé céc
chau cdm bj cong hay khéng.

*  Dam bao da bat may tinh.

Nut AUTO (Tw dong) khong hoat dong

« Chlrc néng tw dong chi ap dung & ché
dd VGA- Analog. Néu khong hai long
vGi két qua, ban c6 thé thwc hién cac
diéu chinh tht cong qua menu OSD
(hién thj trén man hinh).

& Ghicha

Chtrc nang Auto (Tw dong) khong ap

dung & ché do DIV-Digital (DVI-KTS) vi n6

khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

+ Khong thyc hién bat ky budc khac
phuc sy cO nao

« Ngét ngay két néi man hinh khéi 6
cam dién chinh cho an toan

» Lién hé ngay v¢&i dai dién dich vu
khach hang cta Philips.

E Cac sw cd hinh anh

Hinh anh khéng nam gitra tam man hinh

* Chinh vj tri hinh &nh qua chlrc nang
“Auto” (Tw doéng) trong cac nut didu
khién chinh trén menu OSD.

* Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/Bdng hd) clia Setup (Cai
dat) trong céc nut diéu khién chinh
trén menu OSD. N6 chi ¢ hiéu luc &
ché d6 VGA.

Hinh anh rung lén trén man hinh

. K[ém tra xem cap tin hiéu da dwoc
cam chat dung cach vao bang mach
do hoa hay may tinh hay chwa.

Hién thi hién twong chap chon doc



«  Chinh hinh anh qua ch&c nang “Auto
(Tw ddng)” trong cac nut didu khién
chinh ctia menu OSD.

» Loai bé cac vach doc qua Phase/
Clock (Géc pha/béng hd) ctia Setup
(Cai d&t) trong cac nat diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwc & ché do VGA.

Hién thi hién twong chap chén ngang

* Chinh hinh anh qua chirc nang “Auto
(Tw doéng)” trong cac nuat diéu khién
chinh ctia menu OSD.

* Loai bd céac vach doc qua Phase/
Clock (Géc pha/Bdng hd) cliia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwe & ché do VGA.

Hinh anh hién thi nhoe, khéng ré hoac

qua m&

* Chinh d6 twong phan va do sang trén
menu Hién thi trén man hinh (OSD).

» o«

Hién twong “anh ao”, “anh thir néng”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

« Hién thi lién tuc cac anh tinh trong mot
thoi gian dai co thé gay ra hién twong
“anh thtr néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh ao”
hay “Anh béng ma” 1a hién twong phd
bién trong cong ngh& man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r nong” hoac “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh
chuyén ddng khi ban khéng st dung
man hinh.

e Lubn bat (rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
clia ban sé hién thj nhitng ndi dung
tinh khéng thay déi.

« Khong thé kich hoat trinh bao vé
man hinh hodc (*rng dung nap lai man
hinh dinh ky c6 thé gay ra cac sw cb
nghiém trong nhw “tht¢r néng” hoac
“anh sau” hodc “anh béng ma” vén
s& khong biét mét va ciing khéng thé
khéc phuc. Thiét hai nhw trén khong
nam trong chinh sach bao hanh cla
chung toi.

Hinh hién thi bién dang. Van ban bi m¢

hoac nhoe.

+ Cai do phan gidi man hinh may tinh
sang cung ché do v&i d6 phan giai
man hinh géc khuyén duing ctia man
hinh LCD.

Cac cham luc, dé, lam, den va tring

hién thj trén man hinh

« Cac cham con lai la dac tinh thong
thwérng clia man hinh tinh thé 1dng
dung trong cdng nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém thong tin.

Dé'n “bat ngudn” qua sang va gay choi

mat

+ Ban ¢ thé chinh dén “bat nguon” qua
Cai dat dén LED nguon trong cac nut
diéu khién chinh ctia menu OSD.

Pé duwoc tro gitp thém, hay xem danh

sach Trung tam thdng tin khach hang

va lién hé va&i dai dién dich vu cham séc

khach hang cta Philips.



8.2 Héi dap SmartControl Lite

H1. Téi da ddi man hinh trén PC sang
man hinh khac va khéng thé st
dung SmartControl, t6i can lam gi?

Pap: Hay khéi dong lai PC va kiém tra
xem SmartControl Lite c6 hoat dong
khong. Néu khong, ban can phai g&
bo va cai dat lai SmartControl Lite dé
dam bdo cai dat driver thich hop.

H2. Cac chirc néng’SmartControl Lite
da hoat dong tot trwé'c d6, nhwng
gi® n6 khéng hoat dong nira, toi
c6 thé lam gi?

Pap: Néu da thwe hién cac thao tac sau,
thi ban can phai cai dét lai driver man
hinh.

« Da dbi bd thich trng db hoa video

sang moét adapter khac

* Da cap nhat driver video

» Cac hoat dong trén HDH nhuw géi hoac
loat (’ng dung

* Chay Céap nhat Windows va cap nhat
man hinh va/hoac driver video

+ D4 khéi dong Windows bang nut tat
hay ngat két néi man hinh.

«  Dé xac dinh sy cb, hay click chudt
phadi My Computer (May tinh cua toi)
va click vao Properties (Thudc tinh)-
>Hardware (Phan cirng)-> Device
Manager (Quan ly thiét bi).

+ Néu nhin thay “Plug and Play Monitor’
(Man hinh c&m vao 1a chay) hién
thi trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bé
SmartControl Lite va cai dat lai.

H3. Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl
Lite, khong c6 muc nao bat Ién
sau moét lat hoac thong bao 16i
hién thi, diéu gi da xay ra?

Pap: Cé thé Ia do bo thich (rng dd hoa clia
ban khdng twong thich véi t'ng dung
SmartControl Lite. Néu b thich rng

dd hoa la moét trong sé cac nguyén
nhan néu trén, thir tai vé driver bd
thich (rng d6 hoa m&i nhét tir website
clia cac cong ty twong ng.

Cai dat driver. G6 bd SmartControl
Lite va cai dat lai mot 1an niva.

Néu né van khong hoat dong, thi

rét tiéc 12 bd twong trng dd hoa
khong dwoc hd tre. Vui ldng truy cap
website ctia Philips va kiém tra xem
driver SmartControl Lite méi nhat da
c6 sén hay chua.

H4. Khi t6i click vao Product Information
(Théng tin san pham), né chi hién
thi mot phan, diéu gi da xay ra?

Pap: Co thé la do driver b thich trng db
hoa cta ban khong phai la phién
ban cap nhat mai nhat vén hé tro
day da giao dién DDC/CI. Hay th
tai vé driver bo thich &rng d6 hoa
m&i nhét tlr website clia cac cong
ty twong (rng. Cai dat driver. G6 bd
SmartControl Lite va cai dat lai mot
1&n niva.

Attention

Theft Deterence is Enabled

H5. Toi da quén ma PIN cho chirc
niang Theft Deterrence (Chéng
tréom). Toi can lam gi?

Pap: Trung tam dich vu Philips c6 quyén
yéu cau xac nhan va quyén hop lé
d& thiét 1ap quyén s& hivu man hinh.
Xin lwu y chirc ndng chéng trém
dwoc cung cap nhu 13 tiy chon tién
ich mi&n phi. Quan Iy ma PIN 1a
trach nhiém riéng cda nguwdi dung
ca nhan hay té chirc vén dé tao ra
ma nay. Trong trwd'ng hop quén ma
PIN, trung tam dich vu Philips c6 thé
tao lai cho ban v&i mire phi nhé sau
khi xac nhan quyén sé& hiru cia ban.
Xin lwu y chirc nang nay khdong dwoc
bao gébm trong céc diéu khoan bao
hanh chinh thirc.




8.3 Héi bap chung

H1: Khi cai cai dat man hinh, t6i can lam
gi néu man hinh hién thj "Cannot
display this video mode" (Khéng
thé hién thi ché do video nay)?
Pap: D06 phan giai khuyén dung cho man
hinh nay la: 1920x1080@60Hz
+ Ngét tAt ca cac cap roi két néi PC voi
man hinh ma ban da dung trwéc do.
*  Trong Windows Start Menu (Menu
khéi ddong Windows), chon Settings/
Control Panel (Cai dat/bang dieu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twgng Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé "Settings"
(Cai dat). Trong thé cai dat, trong 6
cé tén 'desktop area' (vung man hinh
nén), chuyén thanh trwot sang mirc
1920x1080 pixels.

* M@ thé "Advanced Properties" (Thuéc
tinh ndng cao) va cai Refresh Rate
(Mtrc nap lai) sang 60Hz rdi click vao
OK.

+ Khai dong lai may tinh va lap lai
buéc 2 va 3 dé kidm tra xem PC
clia ban da dwoc cai sang mirc
1920%1080@60Hz hay chua.

. Tat may tinh, ngét két ndi man hinh
¢l va két ndi lai man hinh LCD Philips
cua ban.

« Tt man hinh rdi bat lai PC.

H2: Murc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Dap: Mirc cap nhat khuyén dung cho man
hinh LCD la 60Hz; néu c6 béat ct»
hién twong nhiéu nao trén man hinh,
ban cé thé cai dat mrc nay sang
75Hz dé kiém tra xem mirc méi nay
c6 loai bé dwoc hién twong nhiéu
hay khoéng.
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H3: Cac file .inf va .icm trén dia CD
1a gi? Lam thé nao dé cai dat cac
driver (.inf va .icm)?

Dap:Day la cac file driver cho man hinh
clia ban. Thwc hién theo cac chi dan
trong s tay str dung dé cai d&t cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) ho&c 1&p dia driver khi ban
cai d&t man hinh 14n dau. Thyc hién
theo cac chi dan dé 14p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat tw dong.

H4:
Pap:

Lam thé nao dé chinh do6 phan giai?
Card video/driver db hoa cla ban

va man hinh sé ciing quyét dinh

cac dd phan gidi c6 san. Ban c6 thé
chon d8 phan giai mong muén trong
Control Panel (Bang diéu khién)

cta Windows® qua thé “Display
properties (Thudc tinh man hinh)”.

H5: Diéu gi sé xay ra néu toéi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nuat OK, rdi chon 'Reset'
(Cai dat lai) dé cai dat tat ca tré vé
cai dat mac dinh gbc.

bap:

H6: Man hinh LCD c6 kha ning chéng
tray xwérc?

N6i chung ban khéng nén dé& bé mat
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khai cac
vat dung sac hay cun. Khi cdm man
hinh, d@m bao khong dung strc ép
hay Iwc manh 1én phia bé& mat man
hinh. Biéu nay cé thé anh hwéng dén
cac diéu kién bao hanh cla ban.

Dap:

Téi nén lau man hinh LCD nhw thé
nao?

Dé lau thong thuong, hay st dung
khan sach va mém. D& lau k¥, hay
duing cdn isopropyl. Khéng diing

cac dung mdi khac nhw cdn étylic,
ethanol, axeton, hexan, v.v...

H7:

Pap:



H8: Toi co thé thay déi cai dat mau sic

cho man hinh?

BPap: Di nhién, ban c6 thé thay dbi cai

dat mau sic qua nuat didu khién trén
menu OSD theo cac quy trinh sau,

+  Nhén “OK” @& hién thi menu OSD
(Hién thi trén man hinh)

«  Nhén "Down Arrow" (Mdii t&n xuéng)
d& chon tuy chon "Color" (Mau) rdi
nhén "OK" dé vao cai d&t mau; cé ba
Iwa chon mau nhw sau.

1. Color Temperature (Nhiét d6 mau):
v&i cac cai dat trong pham vi
6500K, man hinh sé hién thi “néng,
vé&i tin hiéu mau dé-trdng"”, trong
khi nhiét d6 9300K tao ra “tin hiéu
mat lam-trng”.

2. sRGB (Pé-Luc-Lam chuan): day
Ia cai dat chuan dé& dam bao trao
ddi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon): ngwdi dung
cd thé tw chon cai dat mau sac wu
tién bang cach chinh mau dé, luc
va lam.

& Ghichu

Do mau anh sang téa ra tir mot vat dung
trong khi n6 dwoc 1am néng. S6 do nay
duwoc thé hién dwa trén ty lé tuyét doi, (mirc
dd Kelvin). Cac mirc nhiét d6 Kevin thap
hon nhw 2004K |a mau doé; cac mre nhiét
d6 cao hon nhw 9300K Ia mau lam. Nhiét
dé trung tinh 1a mau trdng & mirc 6504K.

H9: T6i cé thé két ndi man hinh LCD véi
moi PC, may chu hay may Mac?

Co thé. T4t ca cac man hinh LCD
Philips déu hoan toan twong thich
véi cac PC, may Mac va may cha
chuan. Ban c6 thé can co dau noi
cap dé két ndéi man hinh méi hé
théng may Mac. Vui long lién hé voi
nhan vién kinh doanh ctia Philips dé
biét thém théng tin.

bap:
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H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cadm vao la
phat)?

C6, cac man hinh Philips d&u hé tro
chudn Plug-and-Play twong thich vé&i
Windows 8/7/Vista/XP/NT, Mac OSX,
Linux

bap:

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

Hién thi lién tuc cac anh tinh trong
mot thi gian dai cé thé gay ra hién
twong "anh th&r ndng", con dwoc goi
la “dnh d0” hay “dnh béng ma”, trén
man hinh ctia ban. “Anh th&r néng”,
“Anh &o0” hay “Anh béng ma” 1a hién
twong phd bién trong cong nghé man
hinh LCD. Trong moi trwdng hop,
hién twgng “anh th&r néng” hay “adnh
40” hay “anh bong ma” sé bién mét
dan trong mét thoi gian sau khi da tat
ngudn.

Ludn bat trinh bao vé man hinh
chuyé&n ddng khi ban khéng s dung
man hinh.

Luén bat wng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD clia ban sé hién thi nhitng noi
dung tinh khéng thay dbi.

) Canh bao

Céc hién twgng “anh thir ndong” hay “anh
40” hay “anh bong ma” sé khéng biét méat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
bao hanh cda chung toi.

bap:

H12: Tai sao man hinh cia téi hién thj
vén ban sic nét va cac ky tw riang
cwa?

Pap: Man hinh LCD cta ban hoat
dong tét nhat & dd phan giai gbc
1920%x1080@60Hz. D& man hinh
hién thi t&t nhat, vui Iong st dung d6
phan giai nay.



84 MHL FAQs

H1: T6i khong thé xem hinh anh tiv

thiét bi di dong trén man hinh

Pap:

+ Hay kiém tra xem thiét bi di déng cla
ban c6 dwoc chirng nhén twong thich
MHL hay khéng.

+ Ban ciing can c6 cap duoc 9hL’Ppg
nhan tuong thich MHL dé két ndi cac
thiét bi.

+  Dam bao ban da két ndi véi cong
MHL-HDMI, va da chon dAu vao thich
hop trén man hinh qua bé chon dau
vao (mat vat trwédc hoac menu OSD
{hién thi trén man hinh})

+ San phdm duoc chinh thirc cong nhan
twong thich MHL. Vi day la man hinh
khong ngudn, nén néu ban gap phai
bét ky sw ¢ bat ng& nao khi str dung
d&u vao MHL, vui long tham khao sb
tay st dung thiét bj di dong hoac lién
hé v&i nha san xuét thiét bi di dong
do.

Attention

No video input(MHL-HDMI)

« Dam bao thiét bj di dong cta ban
chwa vao ché do ché (khéng hoat
dong). Néu da vao ché do nay, thi ban
sé& nhin thdy théng bao hién thi trén
man hinh. Mét khi thiét bj di dong hoat
dong lai, man hinh ciling sé hoat dong
va hién thi cac hinh anh. Ban co thé
can dam bao da chon dau vao thich
hop néu da st dung hodc két ndi véi
b4t ky thiét bi nao khac

H2. Tai sao hinh anh hién thij trén man

hinh c6 chéat lwong kém? Thiét bi di

déng cua téi nhin cé vé tét hon nhiéu.

Dap:

+  Chuén MHL dinh r5 théng s 1080p
@30hz cb dinh cho dau ra va dau
vao. Man hinh twong thich véi chuén
nay. Chat lwong hinh anh tuy thudc
vao chét lwong cla cac ndi dung géc.

«  Néu noi dung c6 dd phan dai cao (vi
du nhw HD hoac 1080p), thi n6 sé
hién thi & dang HD hoac 1080p trén
man hinh nay. Néu néi dung gbc cé
do phan gidi thdp (vi du nhu QVGA),
thi né c6 thé nhin co6 vé tét hon trén
thiét bj di doéng do c& man hinh nhd,
nhuwng s& nhin c6 vé kém chét lwong
hon trén man hinh I&n nay.

H3. T6i khéng thé nghe am thanh tir

man hinh.

bap:

*  Pam bao han hinh cla ban cé céac loa
tich hop va am lwong dwoc bat trén
canh man hinh cling nhw trén canh
thiét bj di déng. Ban ciing c6 thé st
dung cac tai nghe tuy chon.

« Néu man hinh khéng c6 céc loa tich
hop, thi ban cé thé cdm céc tai nghe
ty chon vao dau ra trén man hinh.
Vui long dam bao da bat am lwong
trén canh man hinh cling nhw trén
canh thiét bj di dong.

Dé c6 thém thong tin hodc cau héi

thwong gap (FAQ), vui long truy cap

trang web chinh thirc cua tap doan

MHL:

http://www.mhlconsortium.org
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